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Notes on this manual 

This manual provides you with instructions and information on the function and configuration of 
the PowerDim. It describes the basic operation and shows how to set the menu-based parameters 
of the device.  

 

The PowerDim is customized. For this reason, functions and settings may be described here that 
are not relevant or available for certain specifications of the dimmer. The illustrations also do not 
necessarily correspond to your PowerDim. 

 

This manual uses the following symbols to indicate important information for your safety and con- 
figuration. 

 

 
Here you will find additional information 

  

 

Attention draws your attention to situations in which decisions can lead to technical 
problems with the device or to data loss. 

  

 
A warning refers to situations in which injury or damage to life and limb may occur. 

 

 

Handling instructions 

The LSS PowerDim is designed for continuous operation. However, you should note the following: 

 

 

• Only use the device for its intended purpose! 

• Avoid extreme mechanical loads! 

• Avoid any mechanical impact on the display! 

• Avoid direct exposure to moisture and excessive heat on the appliance! 

• Do not install the device directly above headlights! 
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Safety instructions 

Proper handling of the PowerDim is not dangerous. However, please observe the following instruc-
tions: 

 

 

Caution! High voltage is present inside the dimmer housing! There is a risk to life 
if the housing is opened! 

  

 

Opening the PowerDim housing will invalidate any warranty claims! 

  

 

• Never operate visibly damaged appliances! 

• If a defect is suspected, disconnect the appliance from the power supply im-
mediately! Secure the appliance against restarting! 

• Never open the appliance! There is a danger to life if you open the appliance!  

• Never touch any of the internally installed components!  

• Repairs may only be carried out by employees of LSS GmbH! 

  

  
The dimmer must not be lifted by the side brackets with lifting gear or by hand!  

 

We look forward to receiving your comments on this manual. Please send them by e-mail to 
mail@lss-lighting.de. 

 

History 

 

Date Firmware Description 

07/2017 1.02 First description  

12/2019 1.08 Update menu 

04/2021 1.10 Extension of the Ethernet setting to include Art-Net 4 & RDMnet 

07/2024 2.12 New Firmware 
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Display, connection and operating elements 
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Overview 

Range of configurations 

The LSS PowerDim is a leading edge phase control dimmer in duct design. The dimmer is available 
in various device configurations and output powers: 

 

- 6x 3 kVA Dim/NonDim on Schuko, 400 V/32 A infeed 

- 6x 3 kVA Dim/NonDim on Schuko & parallel multipin,  
400 V/32 A supply 

- 6x 3 kVA Dim/NonDim on multipin, 400 V/32 A supply 

- 6x 3 kVA Dim/NonDim & 6x 3 kVA NonDim on Schuko, infeed 400 V/32 A 

- 6x 3 kVA Dim/NonDim & 6x 3 kVA NonDim on Schuko and multipin, 400 V/32 A power 
supply  

- 6x 3 kVA Dim/NonDim & 6x 3 kVA NonDim on Multipin, 400 V/32 A supply  

- 6x 3 kVA Dim/NonDim & 6x 3 kVA NonDim on connection terminals, 400 V/32 A power 
supply  

- 6x 3 kVA Dim/NonDim & 6x 3 kVA NonDim on Schuko and LL heating coil, 400 V/32 A in-
put  

- 6x 5 kVA Dim/NonDim on DBS, 400 V/63 A supply  

- 6x 5 kVA Dim/NonDim on DBS & parallel MultiCore, 400 V/63 A input  

- 6x 3 kVA / 5 kVA Dim/NonDim & 6x 3kVA NonDim on DBS/Schuko, switchable, 400 V/63 
A power supply  

- 6x 3 kVA / 5 kVA Dim/NonDim & 6x 3kVA NonDim on DBS/Schuko and parallel multipin, 
switchable, 400 V/63 A input  

 

The channel design allows installation on galleries, trusses and other locations close to the stage. 
The aluminum housing with generously dimensioned cooling fins enables cooling without a fan, 
which further supports use close to the stage. The duct design also enables a mechanical connec-
tion with the LSS MF 250x140 multifunctional duct. 
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Further performance features: 

 

- Up to 6 Dim/NonDim circuits  - Control via Ethernet or DMX 

- Up to 6 NonDim circuits  - Can be used as an RDM proxy 

- 3 kVA / 5 kVA power per load circuit pos-
sible 

 - Control incl. Ethernet/DMX node, re-
motely configurable 

- Power switching 3kVA / 5kVA via DMX 
address, possible under full load and 
without changing connectors 

 - Internal current measurement (single 
phase/ total) incl. voltage & frequency 
monitoring, automatic switch-off adjust- 
able 

- Bypass function for loss reduction of the 
dimmer circuits at maximum load 

 - Housing made of extruded aluminum 
profile 

- 8Bit/16Bit control  - Fan less cooling via housing 

- Internal switchable base load   

- 14 stored dimmer curves   

- Adjustable fade-in/fade-out times   

 

Technical structure 

Schematic drawing of an LSS PowerDim as a duct variant with an example configuration: 
 
 
 

 
 
 

 

 
Ethernet connection 

 

Load connections multipin plug con-
nector Dim/NonDim 

 
Dimmer-CPU with network node 

 
Power supply 

 
Lower fuse Dim/NonDim 

 

Load connections Schuko/DBS and 
other Dim/NonDim 

 
The individual dimmers can be grouped and routed to the load outlets by using switching units. 
These outlets can be configured according to customer requirements. In addition to controlling 
spotlights, the LSS PowerDim also offers the option of perfectly controlling and dimming fluores-
cent lamps.  

A D 

B E 

C F 

A B C D 

E F 
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Caution! High voltage is present inside the housing! There is a danger to life when open-
ing the housing! 

   

 

The dimmer must not be lifted by the side brackets by hand or with lifting 
equipment! The side brackets serve as safety devices for the plug connectors 
and connection cables. They are not intended for carrying or lifting the dim-
mer! 

 

   

 
Opening the housing will invalidate any warranty claims! 

 
 

Control unit and network node 

The settings for the LSS PowerDim are made via the control unit. The control unit also serves as a 
controller and network node. In order to perform these tasks without overlapping and therefore 
without process conflicts, the CPU is designed as a dual-core processor. To ensure maximum oper-
ational reliability, the core responsible for the dimmer cannot be addressed directly by the user 
and the data. 

 

Structure of the control unit 

All operating steps are menu-guided with a single control element, an encoder (rotary control). 
The encoder has a turn/push function. 

 

DMX-IN, DMX-THRU and both DMX-OUT are located below the encoder. The inputs and outputs 
are electrically isolated using optical couplers and equipped with EMC filters. 

 

Display 

 

 

Operating-LEDs 

 Encoder 

DMX connections 
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Display 

The LSS PowerDim can be configured locally via a convenient menu system. For this purpose, the 
device contains a blue and white 20x4 display with energy-saving LED backlighting and a long ser-
vice life. 

 

 

 
Use the screen saver! This extends the life of the display many times over. 

  

 

You can adjust the contrast of the display in the menu. However, readjustment is 
usually not necessary as the display is already temperature-compensated. 

 

Another option for configuring the LSS PowerDim is to use the ConfigStudio config-
uration software developed by LSS. All the necessary information can be found later 
in this manual. 

 

Operating LED 

 

LED Color  Meaning 

POWER Blue illuminated:  Operating voltage present 
not illuminated: Operating voltage not present 

ACTIVE/FAIL  Green 
 
 
Red 
 

On:   At least 1 dimmer is activated 
Flashing:  At least 1 dimmer is controlled manually 
 
Flashes briefly: No input voltage on a module 
Flashes 50:50:  Switched off due to overcurrent / temperature 
Flashes for a long time: No output voltage, DimmerCube defective 
Permanently lit: Short circuit 
 
Mutually 
Red/Green or  
yellow flashing: Temperature warning! Non-prioritized channels 
   are reduced in power. 
 
Attention! Messages displayed in red have highest priority! 

LINK Yellow continuously lit: Ethernet is connected 
flashing:  Data reception 

 

 
The operating LEDs can be switched off in the Options menu. 
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Encoder 

Turn the encoder wheel to select the various menu items and buttons. Briefly pressing the encoder 
marks this menu item or button as selected. 

 

 

Network 

The LSS PowerDim can be controlled either via Ethernet or DMX. The control unit is equipped with 
an Ethernet/DMX network node that supports RDM and can be used as a RDM proxy.  

 

DMX parameters 

DMX-In 

Max. receivable data rate: 44 frames/s = Protocol length 22,4ms 

Min. receivable mark-after-break: 4 µs 

Timeout time until reception failure: 2 s 

The DMX signals are logically processed and analyzed by the controller. It therefore fulfils the ANSI 
E1.11 - 2008 (R2013) and USITT DMX512-A standards. 

 

DMX-Out 

The following parameters can be set for all DMX outputs: 

Behavior in the event of reception failure of all 
sources: 

Switch off, hold or send zeros 

Break length: 90…42.28 ms 

Mark-after-Break: 10µs…42.28 ms 

 

DMX termination 

If the LSS PowerDim is the last DMX device on a long and/or interfering DMX line, a commercially 
available termination plug (resistor 120...130 Ω between pins 2 and 3) should be plugged into the 
DMX-THRU as a bus termination to avoid malfunctions. 

 

Ethernet parameters 

Supported network protocols 

The LSS PowerDim supports the following protocols: 

 

• Art-Net • ShowNet 

• AVAB/UDP • AVAB/IPX 

• sACN  

Data transfer rate 

The LSS PowerDim is characterized by a high throughput rate and low latency (delay time) in both 
directions. The network interface is 100 MBit-capable and the internal CPU works with a very fast 
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real-time multitasking operating system. This enables a maximum throughput of >1000 network 
packets per second.  

The standard network protocol of the LSS PowerDim on delivery is the manufacturer-independent 
streaming ACN. The protocol version currently used is Art-Net 4 

 

 

Light parameters 

You can set the following parameters for all light protocols: 

• Minimum transmission rate without value change 20 ms ... 4s 

• Timeout time 1...999 s (hold etc. is set per DMX-Out, see there) 

• Timeout can only be set globally, but is checked individually for each Universe used 

 

IP parameters 

You can also specify the following parameters for all TCP/IP-based lighting protocols: 

 

Selection Meaning 

Static manual: Free setting option for the IP, subnet and gateway address. The setting is re-
tained after a restart. 

Art-Net2/8: Art-Net address in the 2 network. The address and subnet mask are generated 
automatically. 

Art-Net10/8: Art-Net address in the 10 network. The address and subnet mask are generated 
automatically. 

10.0.0.0/8: Manual setting of an IP address in the 10 network (RFC 1918). 

First byte and subnet mask are defined. 

172.16.0.0/12: Manual IP address in the 172.16 network (RFC 1918). Octet 3 and 4 are freely 
adjustable. 

192.168.0/16: Manual IP address in the 192.168 network (RFC 1918). Octet 3 and 4 are freely 
adjustable. 

Test1 /24: Manual IP address for test purposes (RFC 6890).  

Network 192.0.2.0. octet 4 is freely adjustable 

Test2 /24: Manual IP address for test purposes (RFC 6890).  

Network 198.51.100.0. octet 4 is freely adjustable 

Test3 /24: Manual IP address for test purposes (RFC 6890).  

Network 203.0.113.0. octet 4 is freely adjustable 

DHCP: Automatic assignment of an IP address by a DHCP server. 

LinkLocal/16 IPv4LL/ZeroConf address, 169.254.0.0/16 
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Merge behavior 

The LSS PowerDim can merge up to 4 HTP or LTP systems that transmit on the same sub- net/uni-
verse. This distinguishes it from most other devices of this type. Art-Net, for example, only pro-
vides for 1 or max. 2 systems. 

 

Priorities are also supported if the lighting protocol permits this. However, no manufacturer- spe-
cific extensions, such as "Priorities per circuit", are supported 

 

Remote configuration 

For all LSS devices, we recommend the free LSS ConfigStudio software, which supports all features 
of the LSS PowerDim and other LSS devices, as well as Art-Net devices from other manufacturers. 
Only with this software is it possible to locate all devices in the network and configure the LSS 
PowerDim completely remotely. 

 

As an Art-Net-compatible device, the LSS PowerDim works seamlessly with Art-Net software tools 
from other manufacturers, such as the DMX-Workshop program. A limited remote configuration is 
also possible via this tool. Please note that Art-Net can only configure a subset of the LSS Pow-
erDim here.  

 

 

The LSS PowerDim can always be configured with ConfigStudio even if lighting pro-
tocols other than Art-Net are set; the only requirement is that the PC is within the 
IP address range of the LSS PowerDim. 
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The menu and its settings 
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Notes on using the menu 

Structure and selection 

The menu structure of the PowerDim is arranged hierarchically. The first level is the run-through, 
from which the main menu is accessed. From the main menu, the other submenus are divided the-
matically into levels.  

 

Menu selection 

Turning the encoder selects the different menu items and buttons with a moving ►. Pressing the 
encoder briefly selects this menu item or button. 

 

 

Make and save settings 

The settings for the PowerDim are made in the “Config”, Options and Manual main menus. Turn 
and press to call up submenus or select and adjust settings. The settings are only applied and thus 
be- come effective when you save them. The settings are saved by returning to the higher-level 
menu. The question as to whether the changes should be saved must be answered with „Yes“. 

 

 

Please note that any changes to the settings can have far-reaching consequences 
for your lighting system. The setting options described below also assume that you 
have experience and knowledge of configuring DMX and Ethernet lighting proto-
cols.  
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Throughput 

Pages in the flow 

The LSS PowerDim menu scrolls through various diagnostic pages that provide a quick overview of 
various settings and the operating status of the device. The scroll can be interrupted by turning 
the encoder. The pages can be called up manually by turning the encoder again. Automatic scroll-
ing is indicated by a flashing♥ symbol at the top right. When switching to manual mode, the symbol 
changes to II. 

 

If the encoder is not operated for a longer period of time, the PowerDim automatically returns to 
the cycle. The length of the timeout can be set under Options→Display (default 30s). In the same 
menu under "Default", you can define a higher-level display for the cycle. Monitor screens are ex-
cluded from the automatic return to the cycle. 

 

Messages in flow 

The control unit of the LSS PowerDim can be supplied with power either via the fixed connection or 
via PoE. With PoE supply, the control unit can also be active when the dimmer, i.e. the power unit, 
is switched off. The following error messages are then displayed in the cycle.  

 

Error message  Meaning 

All Dimmers „B“ Baseboard error 

The dimmer boards are switched off or have not started correctly. 

Current monitors 
show „-.-“ 

Current monitoring failed  

Power supply is switched off. 

Relays show „H“ Switching position of the relays is unknown and HOLD is active. The switch-
ing position of the relays is held 

Voltage monitors 
show „0“ 

Voltage monitoring failed Power supply is switched off. 

Frequency moni-
toring does not 
change 

Frequency monitoring failed Power supply is switched off 

Display „F!“ in Lvl An error has occurred.  

Display „U“ in Fail A circuit breaker was tripped. 

 

When the dimmer is switched on, all circuit boards must start correctly and report to the control 
unit. If a board does not start or the feedback to the control unit fails, the dimmer is switched off 
by the control unit. 
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Menu structure 

 

 
 

In the initial state, the device displays one of the 11 information pages. Pressing the encoder 
wheel for 1 second takes you to the main menu of the LSS PowerDim. The menu structure is hier-
archical and includes submenus for information, function settings and general device settings. This 
results in level 1 (right-hand column) being labelled View, “Config” and Options. The structure of 
the submenus is described below. 

 

 

 

Monitoring with the View menu 

The monitors in the View menu give you an overview of the current settings of the LSS PowerDim. 
Current events, data input and output are displayed as well as the merge situation. The displays in 
the View menu are monitors and are in real time. This means they can easily be used as monitor-
ing and diagnostic tools. 

 

Level 1 Level 2 Level 3 Level 4 Level 5 Description 

View Dimmer 3kVA, 
5kVA, 
ND 

Addr, Curve, DMX, Cur, Tmp. PWM, CI Display of the current DMX address, dimmer curve, DMX value (decimal 
and percentage), power consumption, temperature of the cube, hexa- 
decimal DMX value l 

DMX In, Out, Fps Display of incoming DMX signals, set hold values, sent packets and set 
frame rate 

RDM Port 1, 
2, D, I 

RDM displays Display of current RDM information per DMX port (except THRU), re-
ceived device information 

Net-
work 

Monitor Port1, 2, 
3 

Hexadecimal display Display DMX port settings 

Coun-
ters 

In, Out, 
Data 

kByte, packets, Errors, 
Dropped, Overrun, Length, 
CRC, Frame, FIFO 

Display counter of sent/received data 

Data Pack./s., kByte Display counter data packets 
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Settings with the Config menu 

 

Dimmer settings 

Joined or single – dimmer- and relays settings as a whole or individually 

The LSS PowerDim offers the option of setting all dimmer channels to the same parameters or as- 
signing individual parameters to each circuit. 

Level 1 Level 2 Level 3   

Config Dimmer ConfigMode Joined: 

All settings are adopted for all dimmer or re-
lay (NonDim) switching channels, DMX ad- 
dresses are assigned automatically after the 
start address. 

Single: 

Each circuit is set individually 

 

DimmerOut and RelayOut – Address- and parameter settings 

 

Level 1 Level 2 Level 3  Level 4 

Config Dimmer Dimmer Out Setting of all dimmer-relevant parameters 
such as DMX address, curve, backup level, 
baseload, fade-in and fade-out times etc. 
NonDim mode can also be set for the dimmer 

Relay Out DMX address, switch level and backup level 
for the NonDim channels 

 

The bypass parameter is a special setting. If this is set to Auto, the bypass function is acti-
vated after a preset time at 100% load, bypassing the Thyristor and thus reducing the 
load. If the dimmer load is reduced, the bypass is deactivated immediately. 

When operating inductive loads (fluorescent lamps) or LEDs, a minimum load is required 
for correct operation. This can be switched on as a base load in the dimmer. 

The minimum and maximum dimmable light values as well as the fade-in and fade-out 
times can be set in the device for the dimmer channels. These values cannot be influ-
enced by the lighting control panel. 

In the NonDim settings, a switching threshold can be specified as a percentage. The Switch level 

parameter can be set here between 0 and 100 %.  
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8 Bit/16 Bit control for the Dimmer Mode 

 

For smooth and permanent fade-in/outs with fast-acting loads the LSS PowerDim is equipped with 
a 16 bit control. This can be switched on and off via the configuration menu. 

 

 

setting meaning  

Off 8 Bit-control active 

On 16 Bit control active 

 

 

Switching the control to 16 bits can have an effect on the DMX addressing! If you 
are using “Single” operating mode, check whether DMX addresses have been as-
signed twice! 

 

Allocation of DMX addresses in AddressMode Joined in 8-bit and 16-bit mode 

The number of DMX addresses depends on the number of channels in the PowerDim. If the start 
address of the first channel is ≠ 1, the following addresses change according to the set start ad-
dress.  

 

 

Default DMX address for all PowerDim 6x 3kVA without Power switching 

channel DMX address 8 Bit DMX address 16 Bit 

Dim/NonDim 1 1 1 and 2 

Dim/NonDim 2 2 3 and 4 

Dim/NonDim 3 3 5 and 6 

Dim/NonDim 4 4 7 and 8 

Dim/NonDim 5 5 9 and 10 

Dim/NonDim 6 6 11 and 12 

NonDim 1 7 13 

NonDim 2 8 14 

NonDim 3 9 15 

NonDim 4 10 16 

NonDim 5 11 17 

NonDim 6 12 18 
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Default DMX addresses for all PowerDim 3x 5kVA/3kVA with Power switching  

channel DMX address 8 Bit DMX address 16 Bit 

3kVA Dim/NonDim 1 1 1 and 2 

3kVA Dim/NonDim 2 2 3 and 4 

3kVA Dim/NonDim 3 3 5 and 6 

3kVA Dim/NonDim 4 4 7 and 8 

3kVA Dim/NonDim 5 5 9 and 10 

3kVA Dim/NonDim 6 6 11 and 12 

5kVA Dim/NonDim 1 7 13 and 14 

5kVA Dim/NonDim 3 8 15 and 16 

5kVA Dim/NonDim 5 9 17 and 18 

NonDim 1 10 19 

NonDim 2 11 20 

NonDim 3 12 21 

NonDim 4 13 22 

NonDim 5 14 23 

NonDim 6 15 24 

3kW/5kW Switching 1 16 25 

3kW/5kW Switching 3 17 26 

3kW/5kW Switching 5 18 27 
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Default DMX-Adressen PowerDim mit Leistungsumschaltung 6x 5kVA/3kVA 

channel DMX address 8 Bit DMX address 16 Bit 

3kVA Dim/NonDim 1 1 1 and 2 

3kVA Dim/NonDim 2 2 3 and 4 

3kVA Dim/NonDim 3 3 5 and 6 

3kVA Dim/NonDim 4 4 7 and 8 

3kVA Dim/NonDim 5 5 9 and 10 

3kVA Dim/NonDim 6 6 11 and 12 

5kVA Dim/NonDim 1 7 13 and 14 

5kVA Dim/NonDim 2 8 15 and 16 

5kVA Dim/NonDim 3 9 17 and 18 

5kVA Dim/NonDim 4 10 19 and 20 

5kVA Dim/NonDim 5 11 21 and 22 

5kVA Dim/NonDim 6 12 23 and 24 

NonDim 1 13 25 

NonDim 2 14 26 

NonDim 3 15 27 

NonDim 4 16 28 

NonDim 5 17 29 

NonDim 6 18 30 

3kW/5kW switching 1 19 31 

3kW/5kW switching 2 20 32 

3kW/5kW switching 3 21 33 

3kW/5kW switching 4 22 34 

3kW/5kW switching 5 23 35 

3kW/5kW switching 6 24 36 
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Routing – settings for data processing and merging 

The dimmer as ist own universe 

The settings for merging and data processing are defined for each DMX-Out in this menu. 
The dimmer is regarded as a separate universe, as DMX-Out 3, so to speak  

 

Menu structure 

 
Level 2 Level 3 Level 4 Level 5 Description 

Routing DMX-Out 
1/2, Dim-
mer 

Failmode Off, Hold, Backup Setting behavior in the event of reception failure. Off switches 
off, Hold retransmits the last received value, Backup sends 
packets with "0" values or the set backup level is maintained. 

Merge Off, Network, Net+Dmx  Merge source setting. 

Precedence HTP, LTP HTP- or LTP merging 

Universe (protocol-dependent) Setting the universe. 

Subnet / 
Priority 

(protocol-dependent) Subnet/Priority setting. 

DMX-In Timeout 1 … 10 Setting the DMX-In timeout in seconds 

Mode On, Off Activation of routing into the network 

 
 
 

DMX – Setting the DMX and RDM properties 

Menu structure 

Factory Settings are shown in bold. 
Level 2 Level 3 Level 4 Level 5 Level 6 Description 

DMX Def Load default values of all DMX settings for max. data speed. Settings must be 
saved to activate. 

RDM RDM Port1,2,In Off, On Switch on RDM for selected port 

Discovery Port1,2 Off, On Switch on RDM Discovery. 

Intervall 1 - 65535s Setting the interval times for Discovery. 

Incremen-
tal 

Off, On Switch on Incremental Discovery. 

Background Off, On Switch on the background mode for Incremental Discovery. 

Break 90 - 200 - 42280µs Setting the break length. 

MAB 10 - 20 - 42280µs Setting the length of the mark-after break. 

Frames 3 - 44/s Setting the frame rate. 

Channels 0 – 512 Setting the bit length of the DMX protocol. 

ProtTime Nur Anzeige Display of the calculated protocol time 

Ad-
drMode 

Joined, Single Enter whether the DMX address can be set as a start address or individually. At-
tention! This setting overrides the “Config” Mode setting in the dimmer menu!! 
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Network – Setting the Ethernet settings 

 

Rx Prot – Setting the receive protocol 

Selection Meaning 

Rx Prot Setting the light protocol for data reception: 

• Art-Net • AVAB/UDP • AVAB/IPX 

• ShowNet • sACN  
 

Rx Tmo Setting the timeout for data reception 1...999. 

 

Tx Prot – Setting the transmission protocol 

Selection Meaning 

Tx Prot Setting the transmission network protocol: 

• Art-Net • AVAB/UDP • AVAB/IPX 

• ShowNet • sACN  
 

Tx Rate Setting the minimum transmission rate if no values change. 20ms … 4s 

 

IP Mode – Setting the Ethernet IP address 

Selection Meaning 

Static manual: Free setting option for the IP, subnet and gateway address. The setting is re-
tained after a restart. 

Art-Net2/8: Art-Net address in the 2 network. 

The address and subnet mask are generated automatically. 

Art-Net10/8: Art-Net address in the 10 network.  
The address and subnet mask are generated automatically. 

10.0.0.0/8: Manual setting of an IP address in the 10 network. The first byte of the ad-
dress and subnet mask are set. 

172.16.0.0/12: Manual setting of an IP address in the 172.16.0.0/12 network. The first and 
second byte of the address and subnet mask are set. 

192.168.0.0/16: Manual setting of an IP address in the 192.168.0.0/16 network. The first and 
second byte of the address and subnet mask are set. 

Test1: Manual setting of an IP address in the 192.0.2.0/24 network. The first, second 
and third byte of the address and subnet mask are defined. 

Test2: Manual setting of an IP address in the 198.51.100.0/24 network. The first, sec-
ond and third byte of the address and subnet mask are defined. 

Test3: Manual setting of an IP address in the 200.0.113.0/24 network. The first, sec-
ond and third byte of the address and subnet mask are defined. 

DHCP: Automatic assignment of an IP address by a DHCP server. 
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LinkLocal/16 Automatic address for mDNS networks. 

 

 

IP2 – Setting a second IP address 

This can be used to set a second alias IP address if this is required for Art-Net and the actual IP ad- 
dress is in a different network.  

 

Selection Meaning 

Off: Second IP address is deactivated. 

Art-Net2/8: Art-Net address in the 2 network. The address and subnet mask are generated 
automatically. 

Art-Net10/8: Art-Net address in the 10 network. The address and subnet mask are gener-
ated automatically. 

 

Setting the manual IP, subnet mask, gateway and DNS-server address 

If the "Static manual" setting is selected in IP mode, the IP address and subnet mask can be en-
tered freely. For all other settings, only individual octets can be changed or the addresses are only 
displayed here. 

 

The gateway and DNS server address can always be set freely. 

 

Selection Meaning 

IP Input/display of the IP address. 

SN Input/display of the subnet address (network mask) 

GW Input/display of the gateway address. 

DN Enter/display the DNS server address for RDMnet. 

 

Services – Setting network services for RDMnet 

Selection Meaning 

Telnet Switches on the Telnet protocol for log messages. 

On:  Activates Telnet 

Off:  Deactivates Telnet 

mDNS Switches on the multicast DNS protocol. 

On:  Activates mDNS 

Off:  Deactivates mDNS 
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Selection Meaning 

RDM Setting how RDM is sent to evaluation devices via Ethernet. 

Off:  The LSS PowerDim does not send RDM via Ethernet 

ArtNet: RDM data is sent via ArtNet. 

Hostname Display of a unique network name consisting of the device name and part of 
the MAC address. Example: "PowerDim-2ba6d9" 

Domain Entry of a top-level domain as part of a Fully Qualified Domain Name (FQDN). 
Always "..local" in internal networks 
Example of an FQDN: "PowerDim-2ba6d9.local" 

 

Options – Setting optional Properties 

Selection Meaning 

ArtNet 3 Net Setting the ArtNet 3 network address. Values 0 … 127 

ArtNet Bcast Art-Net is sent as a broadcast. 

On:  Activated Send as broadcast 

Off:  Deactivated Send as broadcast 

ArtNet 4 Switches on the Art-Net 4 protocol. 

On:  Activates the Art-Net 4 protocol 

Off:  Deactivates the Art-Net 4 protocol 

Light TxChan Setting the circuits of a Universe sent to the Ethernet network. This function is 
only active if the selected transmission network protocol supports this func-
tion. 

sACN Discov Switches on the sACN Discovery protocol. 

On:  Activates the sACN Discovery protocol 

Off:  Deactivates the sACN Discovery protocol 

sACN Draft Selection of the supported sACN protocol 

On:  sACN according to standard E1.31 R0 Draft 

Off:  sACN according to standard E1.31 2018 

sACN ChanPri Switch on the channel priority, if supported by the protocol 

UDPChksm Setting for calculating the checksums of UDP data packets  

Rx & Tx Checksums for received and sent packets 

Rx only  Checksums only for received packets 

Tx only  Checksums only for sent packets 

Off  Checksum calculation from 

TCP MSS TCP Maximum Segment Size 

Only change the default setting if necessary 

EthMedia Setting the transmission speed 

Autoneg. Automatic determination of the transmission speed 

10 Half  10 MBit/s Half Duplex 
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10 Full  10 MBit/s Full Duplex 

100 Half 100 MBit/s Half Duplex 

100 Full 100 MBit/s Full Duplex 

 

Power – Setting the current monitoring 

Menu structure 

 
Level 2 Level 3 Level 4 Description 

Power LineVoltage 85 - 230 - 300V Setting the nominal mains voltage. 

MaxCurr L1 1 - 63 - 80A Setting the maximum current for phase 1. 

MaxCurr L2 1 - 63 - 80A Setting the maximum current for phase 2. 

MaxCurr L3 1 - 63 - 80A Setting the maximum current for phase 3. 

MaxCurr 
Sum 

1 - 189 - 240A Setting the total amperage. Attention! For optional relays, their load current must be taken into ac-
count here. 

FreqCon-
trol 

Off, On Activates averaging of the mains frequency of the power supply to reduce flickering of lamps. 

SyncTime  Expert setting! Adaptation of the dimmer to the zero crossing of the local power grid. 

JitterTime  Expert setting! Adaptation of the dimmer to interference signals from the local power grid. 

Relay Time Off, On Time-delayed switching of the relays with simultaneous signal reception 

Fan  On customer request, adjustable fans can be installed, which are controlled here. 

 

 

 

The maximum total current setting always has priority over the three individual 
Phase currents! 

  

 

Setting the limit values for the current does not affect the maximum current. This is 
always defined on the hardware side by the circuit breakers used and the division 
of the phases of the incoming three-phase alternating current. The circuit diagrams 
of the PowerDim, which can be found in the project documentation, must be con-
sulted in order to make a final valid setting! 
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Operating setting in the Options menu 

Level 2 Level 3 Description 

Options Defaults Loading the operating settings. 

Display Shortname Art-Net short name up to 17 characters long. Confirm with a tick at the end of the line. 

Contrast Setting contrast in the display 

MenuTimeout Setting the time until the menu returns to the initial state if no changes are made. Attention! Un-
saved settings will be discarded! 

ScreenSaver Setting the time until the backlight is switched off after the last rotation of the encoder. 

Front LEDs Setting whether operating LEDs are switched off with the display 

Events Setting whether the display (and operating LEDs) should "wake up" due to changes. 

Default Setting the display during scrolling. Scrolling of all pages, permanent display of a fixed page, DMX ad-
dress or user text (7 characters) 

Security Pin Enter a PIN to block access to the device. Values 0 (off) ... 30000 

RemoteCtl Setting whether device can be addressed and set via ArtNet (ConfigStudio/DMX-Workshop). 

Debug Debug See below 

Log Setting the log sources and destinations 

I2C Bus analysis of the I2C, if I2C available 

Dimmer Analyse DIM-CPU and bus transfer between both CPUs 

Reset Triggering a device reset. 

   

Debug 

The debug functionality of the PowerDim is used for troubleshooting. Message priorities and log 
destinations (e.g. Telnet or Syslog) and up to 32 log sources can be selected in the Log subdirec-
tory. The device's internal crash log can also be deleted here. 

 

  
  

The settings here should be selected 
with care. Please only ever select the 
sources and destinations that are ac-

tually required. Otherwise, the amount of in-
formation is so large that troubleshooting be-
comes more complicated. 
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Manual – Manual control of the  
dimmer- and relays 

Prioritizing settings and entries 

The values set in this menu are saved when the menu is exited and then HTP merged with incoming 
light values.  

 

 

If a transmitter with higher values transmits at the same time, these are immedi-
ately merged with the manually set values! Manually set values are not accepted in 
this case! 

All settings in this menu are always subject to the settings in the previous menus, 
especially those of the dimmer configuration! 

 

Example: If a dimmer circuit is selected via "Channel" that has been defined as a NonDim circuit 
under Config→Dimmer→Dimmer Out, then this NonDim circuit switches on its relay when the de- 
fined SwitchLevel is reached or exceeded at the intensity setting. 

 

Manual input of values 

Menu structure 

Level 1 Level 2 Level 3 Description 

Manual Channel Dimmer 1 - 6, 5kVA 1 - 6, Relay Selection of dimmer or relay circuit 

Dim 0 - 100% (nur bei Dimmer) Manual setting of the dimmer values. If HTP is merged with received val-
ues! 

Rel Off, On Manual relay switching (On/Off) 
Channel = Dimmer: Switching 3kVA dim/non dim relay 
Channel = 5kVA-Dimmer: switching 3/5kVA changeover relay 
Channel = Relay:  Switching opt. relay 
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Configuration with ConfigStudio 
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Configuration software ConfigStudio 

The LSS PowerDim can also be configured using the LSS ConfigStudio configuration software. Con-
figStudio is available as free software to download from the LSS homepage. The basics of the soft- 
ware are explained in the "ConfigStudio" manual. The LSS PowerDim manual assumes that these 
basics have been mastered.  

 

From firmware version 2, the LSS PowerDim can only be configured using the ConfigStudio soft- 
ware. The older ConfigCore version is no longer suitable for this. ConfigStudio has a main interface 
that displays devices in a list and contains basic information about them. 

 

 

 
 

 

Device list 

Devices 

ConfigStudio searches all accessible subnets for devices that respond to ArtPoll network packets. 

Devices found are displayed with their IP address and ArtNet short name. 

  

 

1 

 

 

2 
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Each device entry also has a circular symbol that shows the accessibility status in color. The col- 

ours have the following meaning: 

 

 Green: Device is active and responds to status queries 

 Yellow: A response from the device has been pending for at least 4 queries 

 Red: Device is inactive and has not responded to the last queries 

 Blue: Device was added manually and does not exist in the network or phantom mode 

(continuous queries deactivated) is switched on 

Most LSS device entries also have a drop-down menu item called Port configuration. 

 

 

Dynamic windows 

 

In the left-hand area of the program window, you will find the main functions and information for 

the currently selected device. The content of this window always refers to the currently active de-

vice in the list and changes accordingly. 

In the normal state, you will find function buttons, basic information and a sample image here. 

Function keys 

 

 The function buttons provide quick access to important 
functions: 

• Ident: Sends a command to the device, whereupon it 

is signaled acoustically and visually. Must be deac-

tivated again to continue after activation. 

• Default: Resets the device to factory settings. All in-

dividual settings will be lost! 

• Reset: Restarts the device. 

• Eigenschaften (Properties): Opens the configuration window with which all changeable 

properties of the device (except for DMX ports, see Port configuration) can be customized. 
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Basic information  

 

The most important information about the selected device is displayed here in tabular form: 

  

• Langname (Long name): The Art-Net long name of 

the device (usually contains the device type, firm-

ware version, revision and firmware date) 

• Kurzname (Short name): The Art-Net short name 

(device type designation by default) 

• Standort (Location): The location of the device (op-

tional, if empty "undefined“) 

• IP-Adresse: Currently active IPv4 address of the device 

• MAC-Adresse: MAC address of the device in hexadecimal format 

• Firmware Version: Firmware version number of the device 

 

Texts with this symbol can be edited at the respective point and modified for the corre-
sponding device. 

 

 

Port configuration 

 

 

If a device entry is "expanded" in the device list and port configuration is selected, the content of 
the dynamic window changes. 

 

 

The ports of the selected device are displayed graph-
ically and serve as buttons to configure the selected 
port in more detail.  

 

Alternatively, important port properties can be custom-
ized using the elements below the display: 

 

Enable activates or deactivates the physical or network-side out- put of DMX data. 

Universe contains the network universe that is to be used for sending/receiving light data. 

RDM activates/deactivates RDM functions on the physical DMX port. 
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The colored outline of the port shown visualizes the current state: 

 

grey:   Port is inactive - does not send/receive DMX data 

blue:  Zero/Backup - Port is not currently receiving any DMX data, but is sending a basic 

value of 0 

yellow:  Hold - Port is not currently receiving DMX data, but continues to send the last re-

ceived data 

orange:  RDM - Port receives/sends RDM packets 

green:   Port is active and sends or receives DMX data 

 

 

 

If you click on one of the ports, the follow-
ing window appears. It contains all the 
settings for the selected port. 

 

 

 

 

 

 

 

Transferring settings 

Settings on the devices are not made directly and in real time, but after confirmation by the user. 
This is done on the one hand to keep data traffic in the network low and to minimize errors in the 
settings. A note under the device list indicates that changes have been made locally and could be 
sent 
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The properties window 

All settings that do not belong to the physical DMX ports can be adjusted in the Properties window. 
These settings are shown in the following illustrations. 

  
 

The data from the Information category is particularly important for support enquiries. Using 
these values, the technician can recognize device properties that are useful for troubleshooting or 
determining the correct firmware file.  

 

  



PowerDim 

 
 LSS 37 

 

 The Firmware update category contains the settings 
that are important for updating the operating soft- 
ware of the PowerDim. Please only update this soft- 
ware after consultation  

 

 The latest firmware can be downloaded from the LSS 
website via a link (green marking). A password is re-
quired for this. 

 

By clicking on the button with the question mark 
(marked in red), you will receive information on errors 
that occurred during the update process. 
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Attachments 
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Contact us 

If problems occur during operation of the LSS PowerDim, the descriptions and instructions in this 
manual should help you to analyze and rectify the fault. If this is not the case and further assis-
tance is required, please contact LSS Service. 

 

The following information should be available when contacting us: 

 

- Location of the overall system and position of the LSS PowerDim 

 

- Detailed error description 

 

- Detailed description of the troubleshooting carried out so far 
 

- Description of related system or device problems 
 

 

 

Contact address: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Sonnenstraße 5 

D-04600 Altenburg 

Tel.: +49 3447 83550 

mail@lss-lighting.de 
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Licht-, Steuer- und  

Schaltanlagenbau GmbH LSS 
 

EU Declaration of Conformity 

 
 
The manufacturer:  Licht-, Steuer- und Schaltanlagenbau GmbH 
Manufacturer's address: Sonnenstraße 5 
    D-04600 Altenburg/Germany 
 

declares that the product 
 
Product designation:  PowerDim 
 

Complies with the following safety guidelines and standards: 
 

- Low Voltage Directive 2014/35/EU 
- EMV Directive 2014/30/EU 
 

The following harmonized standards were applied: 
 

- EN 55015 
- EN 55103 
- EN 60669 
- EN 61000 

 
The following national standards were applied: 
 

- DIN 56930 
- DIN VDE 0100-100 
- DIN VDE 0100-410 
- DIN VDE 0298 

 
 

Altenburg, 15.01.2018   
     Markus Kaminski 
     Managing Director 
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Device configurations and order numbers 

 

 

Item number Description of the 

L02011-11 6x 3 kVA Dim/NonDim on Schuko, 400 V/32 A infeed 

L02011-12 6x 3 kVA Dim/NonDim on Schuko & parallel mul-
tipin, 400 V/32 A supply 

L02011-13 6x 3 kVA Dim/NonDim on Multipin, 400 V/32 A supply 

L02011-14 6x 3 kVA Dim/NonDim & 6x 3kVA NonDim on Schuko, 400 V/32 
A sup- ply 

L02011-15 6x 3 kVA Dim/NonDim & 6x 3kVA NonDim on Schuko and Mul-
tipin, 400 V/32 A infeed 

L02011-16 6x 3 kVA Dim/NonDim & 6x 3kVA NonDim on Mul-
tipin, 400 V/32 A supply 

L02011-17 6x 3 kVA Dim/NonDim & 6x 3kVA NonDim on connection termi-
nals, 400 V/32 A supply 

L02011-18 6x 3 kVA Dim/NonDim & 6x 3kVA NonDim on Schuko and LL 
heating coil, 
400 V/32 A infeed 

L02011-31 6x 5 kVA Dim/NonDim on DBS, 400 V/63 A supply 

L02011-32 6x 5 kVA Dim/NonDim on DBS & parallel MultiCore, 400 V/63 A in-
feed 

L02011-51 6x 3 kVA / 5kVA Dim/NonDim & 6x 3kVA NonDim on DBS/Schuko, 
switchable, 400 V/63 A infeed 

L02011-52 6x 3 kVA / 5kVA Dim/NonDim & 6x 3kVA NonDim on DBS/Schuko 
and parallel multipin, switchable, 400 V/63 A infeed 
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Technical data 

General data 

Mechanical structure Prefabricated appliance in duct design 

Operation Local:   Menu control with encoder and menu display 

Remote:  Configuration with LSS software „ConfigStudio” 

RDM  RDM message of all settings and measured values 

Display Text display with white backlighting  
(4 lines of 20 characters each) 

Ambient temperature 0 °C – 40 °C 

Operating temperature 0 °C – 60 °C 

Device cooling Standard: Passive via housing 

Optional: Fan with temperature management 

RoHS compliant Yes 

Degree of protec- 
tion/protection class 

IP 20 / SK I 

Color Housing:  Aluminum, black anodized 

Dimensions (L x H x D) 1604 x 210 x 250 mm  
(minimum length, can be adapted to longer lengths) 

Weight Depending on size and equipment, 
fully equipped Single appliance in minimum length: 47 kg 

 

Device functions 

Operating modes Dimmer: Phase control dimmer for all resistive/inductive 
loads occurring in practical operation 

NonDim: Switching with adjustable switching point (e.g. elec-
tronic ballasts for fluorescent lamps and other 
loads) 

Dimmer - Global or single circuit setting 
- Switchable base load 
- Bypass circuit at 100 % load 
- 8Bit/16Bit control 
- 14 Dimmer curves 
- Adjustable fade-in and fade-out times 
- Adjustable minimum and maximum dimming values 
- On reception failure Off, Hold and adjustable backup values 

NonDim (depending on 
device configuration) 

- Hardware NonDim circuit 
- Bistable relay 
- On reception failure Off, Hold 
- Adjustable switching points for all load types 

  



PowerDim 

 
 LSS 43 

 

 

Interfaces 

DMX interface DMX-Out: 2x 5-pin XLR  

DMX-In: 1x 5-pin XLR, HTP 

DMX-THRU: 1x 5-pin XLR 

(ISOLATED according to ANSI E1.11 A1) 

Ethernet interface 1x RJ45 10/100 Mbit/s, transmission speed and automatic detec-
tion manually adjustable 

Network protocols sACN (ANSI E1.31 2018), RDM-Net (ANSI E1.33), Art-Net and Art-
RDM 4, AVAB-IPX, AVAB-UDP, ShowNet 

 

Power supply 

Depending on the device configuration and performance data, the following power supplies are 
possible: 

400 VAC/32 A - Multipin connector 

- Internal via connection terminal (max. 50 mm2) 

- 1.5 m connection cable with CEE plug connector (400 V/32 A, 5-pin) 

400 VAC/63 A - Multipin connector 

- Internal via connection terminal (max. 50 mm2) 

- 1.5 m connection cable with CEE plug connector (400 V/63 A, 5-pin) 

EMV-Standards EN 55022, class B, FCC part 15, level B 

 

Load connections 

Depending on the device configuration and performance data, the following load connections are 
possible: 

For LL channels Plug connector 3-pin + PE (230 - 400 V/10 A)  

4-pin plug connector + PE (230 - 400 V/10 A) 

For 3 kVA channels Multipin- plug connector 16-pin + PE (250 V/16 A)  

Schuko (230 V/16 A) 2-pin + PE (253 V/16 A)  

DBS 2-pin + PE (230 V/16 A)  

For 5 kVA channels Multipin- plug connector 6-pin + PE (400 – 690 V/35 A)  

DBS 2-pin + PE (230 V/26 A)  

The type, size and number of connections for supplying spotlights can be customized to the spe-
cific project. However, they are always subject to the legal regulations and the physical conditions. 

 

Device protection 

Safeguarding the power 
circuits 

Standard: MCB (LS switch) per channel 

Optional: - MCB per channel & RCD (FI) per 6 channels 
- RCBO (FI/LS) per channel 

Current monitoring Overload protection with single-phase monitoring, manual setting 
of the max. load per phase with adjustable switch-off thresholds 
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and max. total load with adjustable total switch-off threshold and 
prioritization of individual circuits 

 

 

Electrical key figures 

Power loss of dimmable 
circuits 

3 kVA: max. 30 W/ power circuit 

5 kVA: max. 50 W/ power circuit 

In each case at 100% control and nominal load 

Rise time 180 µs 

Minimum load 0 VA (not required), for current monitoring 150 W 

 

Pin assignment 

DMX ports 

Assignment according to DMX512 standard 

 

Pin Occupancy 

1 DMX Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE can be routed via the shielding 

 

Ethernet 

The Ethernet connection supports Power-over-Ethernet according to IEEE 802.3af 

 

Pin Occupancy 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Cable shield 

 


